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1. Introduction
In this tutorial we will show you how to build an Excel application to access MySQL via the SOA
Gateway.

2. Prerequisites
It is assumed that you are running the 3 components, MySQL, Excel and the SOA Gateway on
Windows.

It is assumed you already have a SOA Gateway server and Control Centre installed. See here for
more info about installing the SOA Gateway.

3. Setup
It is assumed that you already that MS Excel installed as part of the MS Office suite of products.

You will also need a MySQL database. The Open Source version (known as the MySQL Community
Servey can be freely downloaded from the MySQL website. See this link for download, and here to
step you through the installation and configuration.

3.1.Populate MySQL Database
Now that you’'ve got MySQL installed and config
demo data. For this we use the RisarisBank sample. This is available here .

Save thisfileto”“ GTemp\Ri sari sBank. sqgl"”
9 Connect to the MySQL Server using the mysglcommand.
E.g shell> mysqtu root¢p

This command connects to the server using the MySQL root account to make sure that
you'll have permission to create the RisarisBank database. The - p option tells mysq|
to prompt you for the root password. Enter the password when prompted. (Remember
that the MySQL root account is not the same as the operating system root account
and probably will have a different password.)

9 Create the RisarisBank database.
mysql> CREATE DATABASE RisarisBank;
mysql> use RisarisBank;

1 Load the contents of RisarisBank.sql into the RisarisBank database. E.g.
mysqgl> SOURCETempRisarisBank.sql

9 After the SOURCE command finishes, you can view your new tables.

mysql> SHOWABLES;
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http://www.risaris.com/documentation/v411/installation/index.htm
http://dev.mysql.com/downloads/mysql/5.0.html#downloads
http://dev.mysql.com/doc/refman/5.0/en/windows-installation.html
http://risaris.com/samples/RisarisBank.sql

mysql> DESCRIBEstomerIinformation
mysql> DESCRIBE Branch;

etcX

3.2.Set up ODBC Access
The final thing to do with your MySQL Database is to set up an ODBC DSN which will be used by
the SOA Gateway to access this database.

Click Start, Control Panel, Administrative Tools, Data Sources (ODBC)

From the resulting screen, choose the “System
Click Add
From the |list of data source drivers, select *

If you do not see this driver in the list, you need to install th8@lyConnector. Seerefor
more information. We recommend installing v3.51.

Click Finish, and a window will appear allowing you to enter the DSN information. Add the
following:

Data Source Name: RisarisBank

Description: The Risaris Bank Sample in MySQL
Server: localhost

User: root

Password: *** your MySQL root password ***

Database: RisarisBank (select fom the drop down ligt
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http://www.mysql.com/products/connector/odbc/

nl:unnectur,.-"DDBE 3.51.20 - Add Data Source Mame
™
Connector/0DBC Erought to vou by the database el
VI
Login | Connect Cptions I Advanced I
Database
Daka Source Marme |RisarisBank
Description |The Risaris Bank Sample in My3S0L The database to be current upon connect.
Server I localhost
Optional Yes
Default [none]
ser Iru:u:ut
Password | s
Datahase I RisarisBank] ;I
Test Diagnostics == | (0] 3 Zancel Help

All other options can be left as-is. Click OK.

4. Discovery

Atthis st age you’' va bNpyEQExdat ahase with some sampl e
show you how to create web services from each of the MySQL tables. These web services can be

used in Excel using URL-based queries to give you direct real-time access to your MySQL Data.

4.1.Web Service Creation using SOA Gateway

Start your SOA Gateway Control Centre. See here for an introduction to the Control Centre.

In your servers view, right click the entry which represents your local SOA Gateway Server. Select
“Create New Web Services”
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http://www.risaris.com/documentation/v411/gettingstarted/intro.htm

e —_
.. SDA Gateway Servers (. Eq fit 50A Gateway Sery

«> ¥ ¥ | WebServices I[)ata'lu

Name | M... | ASY | Tracing | il L| Driver
ALY Server Y  OFF/7T

= Lm:al Server
2/05 Server t:gh Refresh Configuration

Suspend Server

2] set Credentials For Server

VAJ Save current Configuration ko server File
& | Import Configuration into Control Center

& Export Configuration from Control Center

5 Export WebService Definition(s) to server

¥ Remove Server definition

&5 Add new S04 Gakeway conneckion

=

From the next dialog, choose “MySQL Driver?”
see how to create one here.

.5!]A Gateway - WebService creation |

This wizard will guide you through the process
of generating new WebServices.

Select the source of data [YFESTR T - =
Discovery timeout fsecunlgu

Mexkt > | Done |

Click Next.

The next screen gives you the ability to add information about your DSN
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http://www.risaris.com/documentation/v411/admin/ccserver.htm#mod_drivers

!SDA Gateway WebService Creation {mysql) Ed

Step 1 - select input

—Specify ODBC descriptors & option(s)

ODBC Dsn IRisarisBank
Userld / Passwurdlruut I-------
Pattern I

Max.entries to list I

— Options for generated WebSeryice name
Advanced Options O

Discover

Cancel

Enter the above information and click Discover.
The wizard will display all the tables it finds at this (RisarisBank) DSN.
Click “Select Al'l”, and click *

The wizard will create web services from each one of these tables.

| mport"?”

;.. SDA Gateway Servers i1 = 0| soa Gateway Server Configuration - Local Server &3
+5 f* 7 || webServices | Dataviews / XDs / X5Ls |
Name | M... | ASy | Mod | Driver | WebService | DataSource Id | Data¥iew |
AlLX Server Y ™ _| MySQL Driver accountsmovements odbeD: isarisBank, table? count: 5 account: 5
DMZ Y \ 1
dublin dey ¥ wigsct MySQL Driver audit odbcD: isarisBank, L dil audit
jk server ¥ My A MySOQL Driver branch odbcDsn=RisarisBank, tableName =branch branch
jk server linux Y ™ 5 .
AETT ¥ Wiy MyS0OL Driver currentaccount odbcDsn=RisarisBank, tableName =currentaccount currentaccount
> Local Server ¥ My th MySOL Driver customeraccountxref odbcDsn=RisarisBank, tableName =customeraccountxref customeraccountxref
Isibre server Y ™
PCRIWS ¥ wysct MySQL Driver customerinformation odbcDsn=RisarisBank, tableName =customerinformation customerinformation
risaris.com server ¥ Wiy D MyS0OL Driver depositaccount odbcD: isarisBank, [ depositaccount depositaccount
vse Y \
2705 Server v et MySQL Driver tellertable odbcDsn=RisarisBank, tableName =tellertable tellertable
z/wse Y
’ H .
You've just created 8 Web Services fro

4.2.Accessing the WSDL

Web Service Description Language (WSDL) is a standard, XML-based language that is used to

describe a Web Service.

For each of the 8 web services

you've

m your 8

created

you with a WSDL to describe the Web Service. The WSDL itself is usually interpreted by a web
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service client, such as Excel, but it is useful to know where to find the WSDL for each of your
Web Services.

As WSDL is XML-based, it will open in your browser of choice. To see the WSDL for one of your
Risaris Bank web services, do the following in your SOA Gateway Control Centre:

9 Click on the web service you are interested in, for example the branch service.

9 The properties for this web service should appear in your Properties View. If you do not
see the Properties view, select Window -> Show View -> Other -> General -> Properties
and click OK.

9 Inthe properties view, there is a link to your WSDL. Click it to open the WSDL in a
browser.

... SOA Gateway Server Configuration - Local Server 3

WebServices | DataViews / XSDs / XSLs |

Mod | Driver | WehService | DataSource Id
My ;-j\'- MySQL Driver accountsmovements odbcDsn=RisarisBank, tableM;
Miy: ;-j\'- MySQL Driver audit odbcDsn=RisarisBank, tableMi
Myt ;.j\'- MySOL Driver branch odbcDsn=RisarisBank, tableN;
Myt ;.j\'- MySOL Driver currentaccount odbcDsn=RisarisBank, tableN;
Ay ;.:\'- MySQL Driver customeraccountxref odbcDsn=RisarisBank, tableN;
Ay ;.j\'- MySQL Driver customerinformation odbcDsn=RisarisBank, tableM;
Miy: ;-j\'- MySQL Driver depositaccount odbcDsn=RisarisBank, tableM:
Myt ;.j\'- MySOL Driver tellertable odbcDsn=RisarisBank, tableM;

... SOA Gateway Action Log 22

| Server name | Me- sage
i LucalServer ______ Hliscovery completed, 8 WebService(s) generated
i Local server ‘ation autosaved due to published WebService modification{s)

L T I, e . L _ 1

£ Properties &3

webService properties

S

Resource + WebService\ §
Name Ihranch
Dataview Ihranch j

Driver IM"'SQL Driver vl SBCS-Codepage I
Read-only [] MBES—EudEpagel

WSDL URL is . http:/localhost:56000, branch?WsDL

= WebService Identification and options

odbcDsn |RisarisBank
schemaMName I
tableName Ihranch
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http://www.risaris.com/documentation/v241/admin/cctop.htm

You can view the WSDL for the other web services by clicking the link from their properties
view.

This WSDL is the starting point for using Web Services, and can be used time and again by
different web service clients.

5. Accessinga Web Service with Excel
We will use the Excel application to access our new Risaris Bank Web Services.

Open MicrosoftExcelClick on the Data tab. Click Get External Data and click the From Web

menu item.
o, = = — =
(O \ = & )7 Bookl - Microsoft Excel
g -
—/ Home Insert Page Layout Formulas Data Review View Developer
- B @ | Connections Al E ( . =5 ﬁ'_‘ #| Data Validation % Group :
—-— . ¢ Propertie - {» Reapply SE= - [Fia Consolidate @ Ungroup ¥ "=
Get External Refresh Z] sort Filter . Textto Remove ) P
Pata~ || Al~ == EditLinks A "/ Advanced || Columns Duplicates £ What-If Analysis ~ ::LjSubtotal
Connections Sort & Filter Data Tools Outline i
fETETET 2 L
@ \ i Bl
-l;-a -" __j _'J _‘J [ T
From From From From Other Existing B F G H ! J K L
|| Access Web Text Sources+ | Connections
l; Get External Data
1

W o N b W

In the Address field type the query you wish to execute e.g.
http://localhost:56000/customerinformation?LIST& CustomerNumber=*

Depending on your SOA Gateway configuration you may have to change localhost and/or the
port number of 56000.
Click on Go.

N.B. At this point, depending on your MySQL security settings, you may get an error message
similar to this one:

<Title>Error</Title><p>ErrorCode = - 11000</p><p>Reason = Mon Apr 21
15:46:20.00595228, pid: 00019601, tid: 00884791. ERROR: in fi le
src/adaptorimpl.cpp, at line 955.

odbcDSDI::workerProcessOdbcDiagnostics() returned - 11000, indicating
ODBC API "SQLConnect" returned " - 1", SQLSTATE is: HY000, Native error
number is; 1044, Message Text is : [unixODBC][MySQL][ODBC 5.1

Driver] Access den ied for user jom'@'localhost’ to database

'RisarisBank' </p><p>Mon Apr 21 15:46:20.00595293, pid: 00019601, tid:
00884791. ERROR: in file src/adaptorimpl.cpp, at line 976.
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http://localhost:56000/customerinformation?LIST&CustomerNumber=*

odbcDSDI::contextlnit() returned - 11000, indicating An external ODBC API
call failed . See previous messages.</p>

The following steps should solve this issue:

 Loginto MySQL as user root.
T I'ssue the following 2 statements substitutdi

your error message:

grant SELECT, INSERT, DELETE, UPDAS&isB&hk.* to 'jom@'localhost;
flush privileges;

Enter the URL as before. Again, depending on your MySQL setup, you may receive a similar
error message as MySQL selects a user login on a hierarchical basis and you may have to repeat
the above for the next user.

If you wish to revoke the assigned privileges do the following:

 Loginto MySQL as user root.
9 Issuet he foll owing 2 statements substituting

your error message:

revoke SELECT, INSERT, DELETE, UPDATE on RisarisBank.* from 'jom'@localhost;
flush privileges;

If valid the query will return the results in the data pane as shown below.

[ Mew Web Query Iil-i_i-]

Address: | http: /localhost: 56000 /customerinformation?LIST &Customeriumber == E @ @M & E‘ Options...

Click [#] next to the tables you want to select, then dick Import.
-

m »

=7xml version="1.0" encoding="UTF-8" standalone="no" 7=
- <customerinformationRoot=

- =<customerinformationGroup =
<CustomerMumber=1</CustomerNumber=
<FirstMame =Casper</FirstName =
<Surname =Ankergren</Surname >
zAddressLinel =34 Green Street</AddressLinel=
zAddressLine2 =Crosses Street</AddressLine? =
<City=Mansfield </City =
<Postcode >MAS 9A1</Postcode>
<DateOfBirth=30/05/1978</DateOfBirth=

</customerinformationGroup =

- zcustomerinformationGroup =
zCustomerMumber=2</CustomerNumber=
<FirstName =Peter</FirstName >
zSurname =Richardson </Surname = +~ [N

[ Import ][ Cancel ]

| hittp: /flocalhost: 56000 fcustomerinformation?LISTCustomerMumber =*# | | |

Now click on Import.
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When the following dialog box is displayed click on OK.

Microsoft Office Excel @lﬁ

e The spedified XML source does not refer to a schema. Excel will create a
schema based on the XML source data.

[] In the future, do not show this message.

] [ Help

You are then asked where you wish Excel to place the data. Here we chose the default of SAS1.
Hit OK.

[ Import Data @Ig

Where do you want to put the data?
(@ XML table in existing worksheet:

Sheetilsasi

() Existing worksheet:

—SF g4 =

() Mew worksheet

Properties... ] [ K ] [ Cancel ]

Excel presents the data in a nicely formatted table as shown.

" L b - h A & TR

On = SR @ s Bookl - Microsoft Excel TableTools

- Home Insert Page Layout Faormulas Data Review WView Developer Design

Table Name: [i5] Summarize with PivotTable g [ Properties V| Header Row First Column EEEEE

Tablel E'ERemove Duplicates & Cpen in Browser Total Row Last Column ===

X Export Refresh . X
T Resize Table u'a Convert to Range - - g2 Unlink V| Banded Rows Banded Columns
Properties Tools External Table Data Table Style Options Table Styles
Al >3 13 | CustomerNumber ¥

A B C D E F G H
[N customernumber K3 FirstName Edlsurname _Bl|Addresstiner ____Edladdresstinez Bllcity B3 postcode E3 pateoiBirth £
2 1 Casper Ankergren 34 Green Street Crosses Street Mansfield MAS 9A) 30/05/1978 1
3 2 Peter Richardson West Gate Avenue Frankfield Manchester MAS 4AA 18/07/1948 r
4 3 Donald Smith 32 Parsons Green Lane Fulham London SWa3IA 05/09/1988
S 4 Lillian Margues 1 Father Delahunty Street Bordesley Birminham BO4 4LW 14/01/1979
6 5 Arthur Holman 12 Padbury Close Griffin Close Newcastle upon Tyne NWB2KK  16/05/1975
7 6 Bartholomew McCarthy 22 Hillview Griffin Close York SW9 1GH 24/03/1974
8 7 Neville Lee 72 Thoresby Crescent Sinfin Leeds LS9 2D5 21/03/1980
9 8 Brian Colman 14 Gilliver Gardens West Field Birmingham BAY 3KK 20/04/1983
10 9 lan Burton 144 Allestree Lane Lime Kiln Lane York YRO 2NT 06/09/1971
11 10 Grenville Dekker 22 Uttoxter New Road Chaddesden Leeds LS4 9WB 21/10/1974
12 11 Jane Freeman 3 Portland Street Lichfield Gloucester GL4 8KD 26/10/1980
13 12 Dale Rolling The Hunters Rest Branston Preston PR4 4HG 06/12/1989
14 13 Arnold Corrigan 14 Anderson Street Allestree Derby DE6 8FT 10/06/1970
15 14 Alfred Summerscale 3701S. George Mason Melbourne Bath BAG 3UU 07/08/1982
15 Peter Spiegel 11663 Charter Oak Co Foremark Manchester M98 4GT 29/12/1971
Sheet1 . 'Sheet2 - Sheetd %1 [ m |
Ready | I3 | [(BOm S +
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6. Conclusion
This tutorial shows how to access MySQL from Excel using the SOA Gateway. As you can see, you
have built a powerful application that uses Web Services to retrieve information in real-time.
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